Notice

The material contained in this manual, and in the online help for the software used to support this instrument, is believed adequate for the intended use of the instrument. If the instrument or procedures are used for purposes other than those specified herein, confirmation of their suitability must be obtained from TA Instruments. Otherwise, TA Instruments does not guarantee any results and assumes no obligation or liability. TA Instruments also reserves the right to revise this document and to make changes without notice.

TA Instruments may have patents, patent applications, trademarks, copyrights, or other intellectual property covering subject matter in this document. Except as expressly provided in written license agreement from TA Instrument, the furnishing of this document does not give you any license to these patents, trademarks, copyrights, or other intellectual property.

TA Instruments Operating Software, as well as Module, Data Analysis, and Utility Software and their associated manuals and online help, are proprietary and copyrighted by TA Instruments. Purchasers are granted a license to use these software programs on the module and controller with which they were purchased. These programs may not be duplicated by the purchaser without the prior written consent of TA Instruments. Each licensed program shall remain the exclusive property of TA Instruments, and no rights or licenses are granted to the purchaser other than as specified above.
Trademarks and Patents

The following references apply to the information presented in this document:

**TA Instruments Trademarks**

Q Series™ is a trademark of TA Instruments Waters—LLC, 109 Lukens Drive, New Castle, DE 19720.

Advantage Integrity™ is a trademark of TA Instruments Waters—LLC, 109 Lukens Drive, New Castle, DE 19720.

Modulated DSC® and MDSC® are registered trademarks of TA Instruments Waters—LLC, 109 Lukens Drive, New Castle, DE 19720.

Tzero™ is a trademark of TA Instruments Waters—LLC, 109 Lukens Drive, New Castle, DE 19720.

µTA® is a registered trademark of TA Instruments Waters—LLC, 109 Lukens Drive, New Castle, DE 19720.

Smart Swap™ is a trademark of TA Instruments Waters—LLC, 109 Lukens Drive, New Castle, DE 19720.

Hi-Res™ is a trademark of TA Instruments Waters—LLC, 109 Lukens Drive, New Castle, DE 19720.

Mobius Drive™ is a trademark of TA Instruments Waters—LLC, 109 Lukens Drive, New Castle, DE 19720.

Orchestrator™ is a trademark of TA Instruments Waters—LLC, 109 Lukens Drive, New Castle, DE 19720.

**TA Instruments Patents**


(continued on next page)
TA Instruments Patents (continued)

Method and Apparatus of Modulated-Temperature Thermogravimetry (MTGA™) describes proprietary technology patented by TA Instruments—Waters LLC (U.S. Patent Nos. 6,336,741 and 6,113,261).

Modulated-Temperature Thermomechanical Analysis describes proprietary technology patented by TA Instruments—Waters LLC (U.S. Patent No. 6,007,240).


Method and Apparatus for High Resolution Analysis of the Composition of a Material describes proprietary technology patented by TA Instruments—Waters LLC (U.S. Patent No. 5,368,391 and 5,165,792. Additional Patent Nos. CA 2,051,578 and DE, EP, FR, GB, IT 0494492).


Dynamic and Thermal Mechanical Analyzer Having an Optical Encoder with Diffraction Grating and a Linear Permanent Magnet Motor describes proprietary technology patented by TA Instruments—Waters LLC (U.S. Patent No. 5,710,426).

Thermogravimetric Apparatus describes proprietary technology patented by TA Instruments—Waters LLC (U.S. Patent No. 5,321,719).

Power Compensation Differential Scanning Calorimeter (Tzero) describes proprietary technology patented by TA Instruments—Waters LLC (U.S. Patent No. 6,428,203).

Differential Scanning Calorimeter (Tzero) describes proprietary technology patented by TA Instruments—Waters LLC (U.S. Patent No. 6,488,406).


Rotary Rheometer (Peltier concentric cylinder) describes proprietary technology patented by TA Instruments—Waters LLC (U.S. Patent No. 6,588,254).
Other Trademarks

Windows® NT, 2000, XP, 98, 98SE, Me, Microsoft Excel® and Microsoft Word 97® are registered trademarks of the Microsoft Corporation.

Adobe® Acrobat® Reader® is registered trademarks of Adobe Systems Incorporated.

Oracle® and Oracle9i™ are trademarks or registered trademarks of Oracle Corporation.

TrueMetrix™ and Scanning Tip Technology™ are registered trademarks of ThermoMicroscopes, Inc.

CHROMEL® and ALUMEL® are registered trademarks of Hoskins Manufacturing Company.

Teflon® is a registered trademark of E. I. du Pont de Nemours and Company.

Loctite® is a registered trademark of the Loctite Corporation.

Swagelok® is a registered trademark of the Swagelok Company.

Inconel® is a registered trademark of Inco Alloys/Special Metals.

X-acto® is a registered trademark of Hunt Corporation.

TYGON® is a registered trademark of NORTON Co.

TA Instruments Q Series modules contain proprietary embedded operating system software copyrighted by Mentor Graphics.
TA Instruments End-User License Agreement

This License Agreement is your proof of license. Please treat it as valuable property.

IMPORTANT - READ CAREFULLY: This is a legal agreement between you (either an individual or an entity) and TA Instruments for this TA Instruments instrument control and/or data analysis software product. By breaking the seal on your disk/CD-ROM package and/or installing, copying or otherwise using this SOFTWARE, you agree to be bound by the terms and conditions of this agreement. Failure to comply with the terms of this license terminates the agreement and your rights to use this software.

TA Instruments Software License

1. GRANT OF LICENSE. This TA Instruments End-User Software License Agreement (LICENSE) grants you the following rights:
   a) Instrument Control Software: This LICENSE permits you to use one copy of the specified version of the TA Instruments instrument control software, provided this software is in use on only one computer at any time. If you have multiple LICENSES for this software, then at any time you may have as many copies of this software in use as you have LICENSES. If the anticipated number of users of this software will exceed the number of applicable LICENSES, then you must have a reasonable mechanism or process in place to assure that the number of persons using this software concurrently does not exceed the number of LICENSES.

   You may also store or install a copy of the TA Instruments instrument control software on a storage device, such as a network server, used only to install or run this software on your other computers over an internal network; however, you must acquire and dedicate a LICENSE for each separate computer on which this software is installed or run from the storage device. A LICENSE for this software may not be shared or used concurrently on different computers.

   b) Data Analysis Software: TA Instruments Thermal and Rheology data analysis software is not restricted to use on only one computer. These programs may be installed on multiple computers for use provided it is for analysis of data generated by the LICENSED instrument control software.

2. OWNERSHIP RIGHTS. The software described above is owned by TA Instruments or its suppliers and is protected by United States copyright laws and international treaty provisions. TA Instruments and its suppliers own and retain all right, title and interest in and to this software, including all copyrights, patents, trade secret rights, trademarks and other intellectual property rights therein. Your possession, installation, or use of this software does not transfer to you any title to the intellectual property in this software, and you will not acquire any rights to this software except as expressly set forth in this LICENSE.

   continued on next page)
3. OTHER RESTRICTIONS. This LICENSE is your proof of license to exercise the rights granted herein and must be retained by you. The following also apply to the software described above as covered by this LICENSE:

   a) You may not rent or lease this software, but you may transfer your rights under this LICENSE on a permanent basis provided you transfer this LICENSE, this software, security key(s), and all accompanying written materials and retain no copies, and the recipient agrees to the terms of this LICENSE. Any transfer of this software must include the most recent update and all prior versions.
   b) You may not reverse engineer, decompile, or disassemble this software, except and only to the extent that such activity is expressly permitted by applicable law notwithstanding this limitation.
   c) This software is licensed as a single product and its component parts may not be separated for use on more than one computer.
   d) Without prejudice to any other rights, TA Instruments may terminate this agreement if you fail to comply with the terms and conditions of this agreement. In such event, you must destroy all copies of this software and all of its component parts.

4. NO WARRANTY: The software described above and documentation are provided on an "as is" basis and all risk is with you. TA Instruments makes no warranties, express, implied, or statutory, as to any matter whatsoever. In particular, any and all warranties of merchantability, fitness for a particular purpose or non-infringement of third parties rights are expressly excluded. Further, TA Instruments makes no representations or warranties that this software and documentation provided are free of errors or viruses or that this software and documentation are suitable for your intended use.

LIMITATION OF LIABILITY: In no event shall TA Instruments or its suppliers be liable to you or any other party for any incidental, special, or consequential damages, loss of data, or data being rendered inaccurate, loss of profits or revenue, or interruption of business in any way arising out of or related to the use or inability to use the software described above and/or documentation, regardless of the form of action, whether in contract, tort (including negligence), strict product liability or otherwise, even if any representative of TA Instruments or its suppliers has been advised of the possibility of such damages.

This LICENSE represents the entire agreement concerning the software described above between you and TA Instruments. It supersedes any prior proposal, representation, or understanding between the parties.

NOTE: The Oracle® software, used in conjunction with the Advantage Integrity software, is not included as part of the TA Instruments’ Advantage Integrity license agreement. Users of Oracle database software must abide by the terms and conditions as specified by the Oracle Corporation.
# Table of Contents

Trademarks and Patents ................................................................. iii

TA Instruments License Agreement ........................................ vi

Notes, Cautions, and Warnings .............................................. xi

TA Instruments Offices .......................................................... xii

**Chapter 1: Introducing the Specialty Library** .......................... 1-1

Overview ................................................................................. 1-1
  - Basic Steps for Data Analysis ........................................ 1-2
  - Getting Help ..................................................................... 1-2

Gathering Data .............................................................................. 1-4

Starting the Program ................................................................. 1-4

Opening a Data File ...................................................................... 1-5
  - Using the Open Data File Window ................................. 1-5
  - Opening the DSC Heat Capacity File Set ...................... 1-6

Verifying Data File Information ................................................. 1-7

Understanding the Main Window ............................................ 1-8
  - Using the Main Menu ...................................................... 1-9

Setting Up Program Parameters ............................................. 1-11

**Chapter 2: Handling Plots and Files** ................................. 2-1

Overview ..................................................................................... 2-1

Using the File Functions .......................................................... 2-1
  - Adding a File .................................................................... 2-1
  - Editing a File Set .............................................................. 2-2
  - Exporting Plots ................................................................. 2-2
  - Printing Plots ................................................................. 2-2
Using the Edit Functions .......................................................... 2-3
  Copying Plots to the Clipboard .................................................. 2-3
  Adding Labels to a Plot .............................................................. 2-3
  Deleting Analysis Results ......................................................... 2-3

Rescaling the Graph .................................................................... 2-4
  Manually Rescaling .................................................................. 2-4
  Using the Zoom Tool ............................................................... 2-5
  Returning to the Original Axis Limits ........................................ 2-6

Changing Graph Options ............................................................ 2-7

Chapter 3: Analyzing Data .......................................................... 3-1

Overview .................................................................................... 3-1

DSC Purity Analysis ..................................................................... 3-3
  Performing a Purity Analysis .................................................... 3-3
  Choosing Purity Analysis Options ............................................ 3-4
  Analyzing the Purity Data ....................................................... 3-6

DSC B&D Kinetics Analysis .......................................................... 3-8
  Performing a B&D Kinetics Analysis ......................................... 3-8
  Choosing B&D Kinetics Analysis Options ................................ 3-9
  Analyzing the B&D Kinetics Data ............................................. 3-10

DSC Heat Capacity Analysis ........................................................ 3-12
  Performing a Heat Capacity Analysis ....................................... 3-13
  Choosing Heat Capacity Options ............................................ 3-14
  Analyzing the Heat Capacity Data .......................................... 3-16

DSC Isothermal Kinetics Analysis ............................................... 3-17
  Performing an Isothermal Kinetics Analysis ......................... 3-18
  Choosing Isothermal Kinetics Options ................................ 3-20
  Analyzing the Isothermal Kinetics Data ................................. 3-23

TGA Kinetics Analysis ............................................................... 3-25
  Performing a TGA Kinetics Analysis ........................................ 3-25
  Choosing TGA Kinetics Options ............................................ 3-26
  Analyzing the TGA Kinetics Data .......................................... 3-29
Notes, Cautions, and Warnings

This manual uses NOTES, CAUTIONS, and WARNINGS to emphasize important and critical instructions.

A NOTE highlights important information about equipment or procedures.

A CAUTION emphasizes a procedure that may damage equipment or cause loss of data if not followed correctly.

A WARNING indicates a procedure that may be hazardous to the operator or to the environment if not followed correctly.
TA Instruments Offices

For information on our latest products and more, see our web site at: www.tainst.com.

TA Instruments—Waters LLC
109 Lukens Drive
New Castle, DE  19720
Telephone:  1-302-427-4000 or
            1-302-427-4040
Fax:  1-302-427-4001

      HELPLINE—U.S.A.
      For assistance with thermal analysis applications, please call the Thermal
      Analysis Help Desk
      at 1-302-427-4070.
      SERVICE—U.S.A.
      For instrument service and repairs,
      please call 1-302-427-4050.

BELGIUM/LUXEMBOURG
TA Instruments a Division of Waters N.V./S.A.
Raketstraat 60 Rue de la Fusée
1130 Brussel / Bruxelles
Belgium
Phone: 32/2 706 00 80
Fax: 32/2 706 00 81

EUROPE
TA Instruments Ltd
Cleeve Road
Leatherhead, Surrey KT22 7UQ
United Kingdom
Phone: 44/1372 360363
Fax: 44/1372 360135

FRANCE
TA Instruments France SARL
1-3, Rue Jacques Monod
78280 Guyancourt
France
Phone: 33/1 30 48 94 60
Fax: 33/1 30 48 94 51
SWEDEN/NORWAY
Waters Sverige AB
TA Instruments Division
PO Box 485 Turebergsvägen 3
SE-191 24 Sollentuna
Sweden
Phone: 46/8 59 46 92 00
Fax: 46/8 59 46 92 09

AUSTRALIA
TA Instruments
C/O Waters Australia Pty. Ltd.
Unit 3, 38-46 South Street
Rydalmere NSW 2116
Australia
Phone: 613 9553 0813
Fax: 61 3 9553 0813
Overview

Before you begin this section, we recommend that you familiarize yourself with the basic operation of the Windows NT® system. Refer to the documentation for the operating system.

This chapter provides you with a brief explanation of the Thermal Specialty Library and general information on getting started. For further details refer to the online help that accompanies the Thermal Specialty Library software.

This program is a powerful tool for the specialized analysis of data obtained from the following TA Instruments analyzers:

- DSC (Differential Scanning Calorimeter)
- TGA (Thermogravimetric Analyzer)
- SDT (Simultaneous DSC-TGA)

This library is made up of specialty analyses that all run within the same main window. When you first open the program, the window (shown here) contains a blank plot area, a right-click pop-up menu, and the initial menu.
The pop-up menu contains items that can be checked to view and unchecked to hide. The menu also allows you to access the main program options. See “Setting Up Program Parameters,” on page 1-13 for details.

**Basic Steps for Data Analysis**

Regardless of the type of analysis that you are performing, the basic steps needed to analyze your data using the Thermal Specialty Library are:

- Gather your data (see the online help for details)
- Choose the type of analysis (see Chapter 3 for information)
- Open the data files
- Verify and enter sample information
- Select data limits, if desired.
- Rescale and adjust the plot as desired.
- Analyze the data
- View and print the resulting reports and data plots.

This chapter provides basic information needed to perform some of the steps in this process. For more detailed information refer to the online help provided in the program. See the next section for the types of help available.

**Getting Help**

The Thermal Advantage programs provide online help to assist you when you need information about the software and its use. The following types of help can be accessed when using the Specialty Library:

**Flyover Help**
To see information about a tool bar button, position the mouse pointer over the button until the text appears.

**Contents and Index**
If you have accessed online help using Windows® NT before, you may already be familiar with the mechanisms used to get help. Just click Help Topics on the Help menu. Then click the Contents tab to scroll through a table of contents for the Help file. Click the Index tab to search for topics by using an index of Help subjects. Click on the Find tab to use full-text search and look for specific words or phrases.
Help Buttons and F1

While using the program, you can click the Help button found on many windows to access helpful information about the items on that window. To get help for menu items, highlight the desired menu item and press the F1 key on the keyboard to get online help. If you want help for a tool bar button you can also hold the mouse button down when clicking on a button and press F1 at the same time, a help dialog is displayed for that button.

Adding Your Own Annotations

You can add your own notes to the help system pages by use of the Options button on the help topic window. Select Annotation from the menu displayed and enter your own text in the window. Any topic that has been annotated with notes will have a paper clip icon to the left of the topic title.
Gathering Data

Each analysis may have slightly specialized methods for obtaining the appropriate type of data for the best results. Please refer to the online help for any detailed information needed to gather data.

Starting the Program

To begin the analyses, select File/New Analysis from the primary menu or click the button on the tool bar. The New Analysis window (shown here) is displayed. The program is made up of six types of analyses: DSC Purity, DSC Borchardt & Daniels Kinetics, DSC Heat Capacity, DSC Isothermal Kinetics, TGA Kinetics, and Thermal Stability Kinetics. Depending on the licensed options on your system, one or more of these analyses will be displayed.

Select the type of analysis desired and click OK.

NOTE: For details on the theory and calculations, see the chapter devoted to the specific analysis desired. This chapter deals with program operations that are common to all the analyses.
Opening a Data File

After choosing the analysis, the next step is to open the appropriate type of data file. If you are doing an analysis that requires a group of data files, called a file set, you will need to subsequently add additional files by selecting File/Add File. If you have chosen to perform the Heat Capacity analysis, a special window is displayed to open the data files, see page 1-6 “Opening the DSC Heat Capacity File Set.”

Using the Open Data File Window

When you need to open a data file for any analysis, the Open File window (shown below) is displayed. Use this window to select a data file. Follow the instructions below to understand and use this window.

1. Click on the “Look in” list to locate the desired folder (directory) containing your data files.
2. Click on a data filename from the list displayed.
3. Select from two checkboxes on the lower right side of window to display information about the selected file in the area above the checkboxes.
4. Select the desired Open Mode from the drop-down list.
5. Click the Open button to open the desired file in the mode chosen above. The default mode is Edit Parameters, consult the online help for additional options.
Opening the DSC Heat Capacity File Set

When you choose the DSC Heat Capacity Analysis, the Heat Capacity Data Files window (shown here) is displayed.

To obtain specific heat capacity analysis you will need three DSC data files: a sample, a baseline, and a reference. The baseline data is used for baseline subtraction from the reference and sample data. For more information on gathering these data files, see the online help.

This window is used to open the three data files.

1. Click the Browse button to locate the following files:
   a. **Sample File**—containing data from an experiment using an unknown sample.
   b. **Baseline File**—containing data from an experiment using empty DSC pans. The baseline should be as flat as possible over the temperature range of interest.
   c. **Reference File**—containing data from a heat flow calibration run using a known, well characterized reference sample.

2. Click the Open button after you have located each file. The Open Data File window described in the previous section is displayed.

3. Click the OK button when you have located all three data files needed and completed the Heat Capacity Data File window. The data will be plotted on the Main window.
Verifying Data File Information

Once you have opened a data file, the Data File Information window (shown here) is displayed, if Edit parameters was selected as the Open Mode. This window is used to verify the information contained in the current data file. Some of the information is not editable here since it is a fixed part of the data file. To change the editable information, follow the instructions below:

1. Verify or edit the desired sample name, sample size, operator name, method description, and comments. (Enter the molecular weight also for Purity analyses.)

2. Select the exotherm direction for your plotted curve, if applicable.

3. Verify or edit the displayed cell constant and/or onset slope, where appropriate.

4. Set the limits on the data plotted, if desired, by clicking the Data Limits button.

5. Select OK when finished. The data file will be plotted on the Main window.
Understanding the Main Window

The Specialty Library’s **Main** window (shown below) provides access to all of the functions needed to customize and perform the various analyses. You can have multiple plot windows opened if more than one analysis is selected. The menus will display the functions applicable to the current analysis.

The **Main** window consists of the plot area, main menu, main tool bar, and a right-click main pop-up menu. (The pop-up menu varies slightly depending upon the current analysis and where the cursor is positioned when the mouse is clicked.)
A brief description of the parts of the main window follows. For detailed information, refer to the online help.

- Main menu: Use this menu to perform the various analysis and editing functions.
- Tool bar: Use this tool bar to open a new analysis, a new data file, perform various editing functions, or print the plot.
- Status/Help line: This area displays the status of the program or helpful descriptions of tool bar buttons when you move the cursor over the buttons.

**Using the Main Menu**

The main menu (see the figure on the previous page) is used to access the various functions that can be performed on the data file.

See the table below for a brief description of each menu available in the main menu. The remaining chapters provide more information.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Use the File menu to open, add, or remove a data file and perform various functions such as exporting plots, printing, and exiting the program.</td>
</tr>
<tr>
<td>Edit</td>
<td>Use the Edit menu to add annotations to the graph and copy the current plot to the clipboard.</td>
</tr>
<tr>
<td>Rescale</td>
<td>Use the Rescale menu items to change the limit range, axis scaling, and zoom in on the portion of the graph that will be analyzed.</td>
</tr>
<tr>
<td>Graph</td>
<td>Use the Graph menu to customize the graph and display the resulting specialty analysis plots.</td>
</tr>
<tr>
<td>Analyze</td>
<td>Use the Analyze menu to analyze the curve and edit the analysis parameters.</td>
</tr>
</tbody>
</table>

*(table continued on next page)*
<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Use the View menu to view and edit reports.</td>
</tr>
<tr>
<td>Window</td>
<td>Use the Window menu to arrange the currently open windows in different configurations.</td>
</tr>
<tr>
<td>Help</td>
<td>Use the Help menu to access help topics, how to help, and product information.</td>
</tr>
</tbody>
</table>
Setting Up Program Parameters

You can set up the way the Specialty Library handles certain tasks by changing the program parameters to meet your specifications.

Select **File/Options** from the main menu. The following window is displayed. Click on the item targeted for a font change, select the font, style, and size and click OK. When you are finished you can click OK to save the selection(s) for this session or click Save to save the selection(s) to the initialization file.

As you can see from the tabs at the top of the window, there are several more program options you can change. A general description of the other options follows:

- **Color Page**: Use this page to select the colors for the plots, results, axes, etc. or to select a whole color scheme to apply to the program.

- **Data Page**: Use this page to choose the way data is plotted (exotherm up or down), the direction of the derivative, and the way data is compacted, opened, plotted, and autoscaled.
• **Appearance Page**: Use this page to decide the appearance of the plots. For example, you can choose what information the plot header should display, the orientation of the plot, what information should be displayed on each axis, the margins desired, and what information should be displayed in the footer, etc.

• **Directories Page**: Use this page to set up the location of the directories (folders) that the program will use to locate information such as data files, initialization files, etc.

• **Initialization Page**: Use this page to set up the initialization file used by the program. You can locate, rename, or load an initialization (.ini) file on this page. The initialization file contains all of the information set up as program options on the other **Main Options** pages.
Chapter 2

Handling Plots and Files

Overview

There are many different things you can do to customize and utilize the data plots in this program. You can change the type and amount of data that is graphed and analyzed, you can export the plot to another application, you can add annotations to the plot and change the way a plot looks, etc. This section provides a brief description of the various plot and file functions. For detailed information, refer to the online help provided with the program.

Using the File Functions

The File menu (shown here) is one of the menus that is present when you first open the program and after you have chosen an analysis and plotted a data file. The next few pages provide a brief description of the operations that can be performed using the options in this menu.

Some of the options on the menu are self-explanatory and will not be discussed here. For example, File/Close closes a file, File/Exit exits the program, etc.

Adding a File

Several types of analyses in the Thermal Specialty Library require multiple files (e.g., TGA Kinetics, Thermal Stability Kinetics, Isothermal Kinetics) in order to analyze the data properly.

When you need to add a file to a multiple-file set, select File/Add File from the main menu.
Editing a File Set

When using an analysis that requires multiple files (e.g., TGA Kinetics, Thermal Stability Kinetics, Isothermal Kinetics), you may want to remove and/or replace a file from the set.

When you need to remove a file from a multiple-file set, select File/Edit File Set from the main menu.

Exporting Plots

When you want to use a plot for another application or have it printed, use the File/Export Plot option to access this window. You can exclude certain parts of the plot, if desired, so that they do not appear in the exported plot through the Main Options — Appearance Page.

Printing Plots

You can print the current plot (shown in the active window) by selecting the File/Print function. The standard print window will be displayed. To change the printer options, select the File/Print Setup function.
Using the Edit Functions

The Edit menu is used to copy plots to the clipboard, and labels to a plot or to delete analysis results. A brief description of each function is given here. For more details on each function see the online help.

Copying Plots to the Clipboard

Click on the plot that you want to copy to activate the plot window. Then select Edit/Copy Plot or select on the tool bar to copy the information to the clipboard for retrieval by the paste option.

This information can be pasted into the Annotation window for display on the curve using the Ctrl+V shortcut keys or by selecting Paste from the pop-up menu. See the next section for a brief description of the annotation functions.

Adding Labels to a Plot

If you want to add your own notes or comments to a plot, you can place annotations (labels) by selecting File/Annotate or clicking on the tool bar. This will open the Annotation window, which allows you to enter and format the text to be placed on the graph.

Deleting Analysis Results

If you decide that you want to repeat an analysis using different data limits or want to remove a result for any reason, position the cursor over the result label, right click to display the pop-up menu shown here, and select Delete Label.
Rescaling the Graph

When analyzing data on a curve, it is often easier to zoom in on a portion that will be analyzed. To do this you can use the zoom box or one of the other options available in the Rescale menu (shown here) or the Rescale tool bar.

This section describes briefly the rescaling options available. For more details refer to the online help.

Manual Rescaling

If you want to change the axis limits used to plot the data or change the labels on the axis, there are three ways to access the Manual Rescale window:

- Select File/Manual Rescale from the main menu.
- Place the cursor over any axis and right click the mouse button.
- Click the button on the Rescale tool bar.

When the window is displayed, you can select exact start and stop limits for the x- and y-axes to reduce or expand the graph, and change the label and tick intervals.

NOTE: The Rescale tool bar is not displayed by default. To display this tool bar, select View/Toolbar/Rescale from the menu.
Using the Zoom Tool

The zoom box provides the fastest way to rescale. You can easily expand a portion of the curve for analysis using the mouse. To zoom in on a particular portion of the curve for analysis, follow these steps:

1. Position the pointer in the general area you wish to enlarge and hold down the left mouse button. As you move the mouse, a zoom box will be drawn from the original point position. Move the mouse to draw a box encompassing the area of the curve to be enlarged.

2. Release the mouse. If the area selected is acceptable, move the pointer inside the box. The pointer changes to a . Click the left mouse button to zoom the X axis and the selected Y axis or click the right mouse button to zoom all axes. (You can also right click inside the zoom box to display the pop-up Rescale menu to accept or reject the scaling changes.)

This process can be used repeatedly to expand a smaller portion of the curve. To return back to the most recent scale changes, click the Undo button,
Returning to the Original Axis Limits

No matter how many times you rescale the axes or what method you use for scaling changes, you can easily restore the plot to its original axis limits by selecting **Rescale/Full Scale Axis** (for one axis) or **Rescale/Full Scale All** (for all graphed axes). Or you can click the ![button](image) button on the Rescale tool bar to return the current axis to its original state or click ![button](image) to return all of the axes to their original state.
Changing Graph Options

In addition to the various ways to alter the original data plot already mentioned, you can also change the data limits that are used when plotting the data points and you can change the type of data that is plotted on each axis. Finally you can also change the colors and fonts used when the data is plotted.

All of these functions can be accomplished using the Graph menu shown to the right. Refer to the online help for detailed information on each option. The following is a brief description of the options.

- You can change the data point limits that are plotted by choosing from one of the Data Limits options on the Graph menu.

- You can change the signals plotted on the X and Y axes using the Graph/X Axis or the Graph/Y Axis menus, if available. Just select the axis you want to change and then select the data you want displayed on the plot. The X axis can be changed to plot either time or temperature and the Y axis can be changed according to the y-axis number.

- To select the graph settings that will apply to the file currently displayed select Graph/Graph Options from the menu or click the button on the tool bar. The Graph Options window (shown here) is displayed. Set up the various options as desired. For information about the dialog, click the Help button.
Chapter 3
Analyzing Data

Overview

The TA Instruments Specialty Library contains six different analyses that can be used to obtain certain types of information. For example, the DSC Purity analysis is used to calculate the absolute purity of a sample and the DSC Borchardt and Daniels Kinetics analysis is used to calculate kinetics parameters. This chapter provides you with some of the information needed to use the different types of analyses on your data.

To help you understand the different analyses available in this program, refer to the following table that gives you information applicable to the analyses:

<table>
<thead>
<tr>
<th>Specialty Analysis</th>
<th>File Input</th>
<th>Specialty Graphs</th>
<th>Specialty Reports</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purity</td>
<td>1 DSC File</td>
<td></td>
<td>Results report</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Area table</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Fit table</td>
</tr>
<tr>
<td>B&amp;D</td>
<td>1 DSC File</td>
<td>Half life</td>
<td>Results report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Conversion %</td>
<td>Half life table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Conversion time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Rate constant</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ln rate constant</td>
<td></td>
</tr>
<tr>
<td>Heat Capacity</td>
<td>3 DSC Files:</td>
<td>Heat Capacity/Total Heat</td>
<td>Results report</td>
</tr>
<tr>
<td></td>
<td>- Sample</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Baseline</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Reference</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Standard)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Isothermal Kinetics</td>
<td>1 or more DSC Files (max. 10 files)</td>
<td>Single run analysis</td>
<td>Single run results report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Multi-run analysis</td>
<td>Multi-run results report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Conversion %</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Conversion time</td>
<td></td>
</tr>
</tbody>
</table>

(continued on next page)
<table>
<thead>
<tr>
<th>Specialty Analysis</th>
<th>File Input</th>
<th>Specialty Graphs</th>
<th>Specialty Reports</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thermal Stability</td>
<td>3 or more DSC Files (max. 10 files)</td>
<td>• Common thermogram</td>
<td>• Kinetics results</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Heating rate</td>
<td>• Hazard results</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Log heating rate</td>
<td>• Half life table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Rate constant</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Half life</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Conversion %</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Conversion time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Thermal runaway time</td>
<td></td>
</tr>
<tr>
<td>TGA Kinetics</td>
<td>3 or more TGA Files (max. 10 files)</td>
<td>• Common thermogram</td>
<td>• Kinetics results</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Heating rate</td>
<td>• Half life table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Log heating rate</td>
<td>• Lifetime table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Rate constant</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Half life</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Conversion %</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Conversion time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Lifetime</td>
<td></td>
</tr>
</tbody>
</table>

NOTE: For help on any window in this program, press the Help button.
DSC Purity Analysis

The TA Instruments DSC Purity Analysis can be used to calculate the absolute purity of a sample based on data obtained from the DSC (Differential Scanning Calorimeter) according to ASTM procedure E0928.*

NOTE: The DSC Purity Analysis is not recommended for analysis of SDT (DSC-TGA) data. The results will not be as expected.

The analysis method used in DSC Purity Analysis is based on the van’t Hoff equation shown below:

\[ T_s = T_0 - \frac{RT_s^2 X}{\Delta H_f} \left( \frac{1}{F} \right) \]

Where:

- \( T_s \) = sample temperature
- \( T_0 \) = melting point of pure sample (K)
- \( R \) = gas constant (8.314 J/mol^{-1} • K^{-1})
- \( X \) = mole fraction impurity
- \( \Delta H_f \) = heat of fusion of pure sample (J/mol)
- \( F \) = fraction of total sample melted at \( T_s \)

* For additional information on purity analysis, see R.L. Blaine and C.K. Schoff, eds., Determinations by Thermal Methods, ASTM Special Technical Publication 838, Publication code 04-838000-40.

+ Annual Book of AST Standards, Volume 14.02, American Society for Testing and Materials (ASTM), 100 Barr Harbor Drive, West Conshohocken, PA 19428-2959, (610) 832-9500

Performing a Purity Analysis

Follow these basic steps when performing a DSC Purity analysis. This section provides you with general information to get you started. Please refer to online help for detailed information.

1. Collect your data. (See online help for details.)

2. Open the Purity analysis and the appropriate data file. Choose the desired analysis options.
3. Analyze (integrate) the melting transition.

4. Display the results report. (See Chapter 4.)

5. Display the data table options. (See Chapter 4.)

Choosing Purity Analysis Options

After you have gathered the appropriate data files by running experiments on the DSC, you can prepare to analyze them. With DSC Purity chosen as your analysis, first open the data file and set it up as desired (see Chapters 1 and 2 for information). You will need to enter the molecular weight of the sample before the data is plotted. Then choose the desired analysis options by selecting Analyze/Analysis Options from the menu or by clicking on the button on the tool bar. The Purity Analysis Options window is displayed (shown here).

1. Verify or enter new partial area parameters. For information on these options, click the Help button.

2. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.

3. Click the Purity Calculation tab at the top of the window. The window shown on the next page is displayed.

4. Set up the calculation parameters as desired. For information on these options, click the Help button.

5. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.
6. Click the **Results Plot** tab at the top of the window. The window shown below is displayed.

7. Set up the plot options and annotation position as desired. For information on these options, click the Help button.

8. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.

---

**NOTE:** To use the factory default options, click the Default button for each Analysis Options page.

**NOTE:** If you make a change to these parameters after analyzing the data, you will need to repeat the analysis again.
Analyzing the Purity Data

Select **Analyze Purity** from the **Analyze** menu (shown here) to perform the analysis on the current data file. The following guidelines should be considered when analyzing:

- When you select **Analyze Purity**, the markers are displayed on the graph to allow you to select the analysis limits. See the online help for tips on using the markers.
- Select the desired analysis limits and select **Accept Limits** from the pop-up menu.
- The program uses the van’t Hoff equation to calculate your sample’s purity, performing a series of operations using the data file.
- First, there is an initial scan of the peak to find the baseline, peak area, and peak height, which are needed to calculate area segments.
- A second scan divides the peak into the number of partial area segments specified on the Purity Analysis Options window (25 is the default) to find the $T_s$ versus $1/F$ curve. The segments are equally spaced along the $1/F$ axis. The first segment ends when the peak height is the specified percent of the maximum height or the input value (10 percent is the default). The last segment ends at the specified maximum percent of the total peak area or the input value (50 percent is the default).

**NOTE:** If the curve does not contain enough points to allow the specified number of segments, the allocation continues until the maximum partial area percent of the total peak is reached.

- A correction is made at the end of each segment for the temperature drop between the sample and sample thermocouple (using the onset slope value entered in the analysis options).
- A nonlinear least-squares technique is used to approximate the area correction for the $T_s$ versus $1/F$ curve. (This is done to linearize the usual curvature of the line, commonly attributed to undetected melting of the sample before peak start.)
• A least-squares fit to a straight line is used to calculate the slope and intercept of the $T_s$ versus the corrected $1/F$ curve.

• Lastly, the van’t Hoff equation is used to calculate the impurity level and convert it to the purity.

• You can also determine the $X$ or $Y$ curve value at a selected point using Analyze/Curve Value at $X$ or Analyze/Curve Value at $Y$. 
DSC B&D Kinetics Analysis

The Borchardt & Daniels (B&D) Kinetics Analysis calculates kinetics parameters, such as reaction order, heat of reaction, activation energy, and Pre-exponential factor, from data obtained during a single linear heating rate scan.

The method used in this program was developed by Borchardt and Daniels** and the ASTM Method E 2041. It is based on the general rate equation for nth-order reactions. For more details on the equations used in this analysis, refer to the online help.

The Borchardt and Daniels Kinetics analysis uses 20 segments of the curve, evenly spaced by temperature. The first segment starts at 10 percent of maximum peak height and the last segment ends at 50 percent of peak area. The values for the kinetics parameters are obtained by a multiple-regression analysis of this data.

It is important that no mass loss occurs during the reaction, so the sample should be placed in a hermetically-sealed pan and weight should be measured before and after the experiment. Sample weight is used in the calculation of heat of reaction, and assumed constant in other calculations.

The cell constant (E value) is calculated using the DSC calibration functions.

Performing a B&D Kinetics Analysis

Follow these basic steps when performing a DSC B&D Kinetics analysis. This section provides you with general information to get you started. Please refer to online help for detailed information.

1. Collect your data. (See online help for details.)

2. Open the B&D Kinetics Analysis and the appropriate data file. Set up the desired analysis options.

3. Analyze the data by integrating the transition peak.

4. Display the results report. (See Chapter 4.)

5. Display the kinetics results. (See Chapter 4.)

Choosing B&D Kinetics Analysis Options

After you have gathered the appropriate data file by running a DSC experiment, you can prepare to analyze it. With DSC B&D Kinetics chosen as your analysis type, first open the data file and set it up as desired (see Chapters 1 and 2 for information). Then choose the desired analysis options by selecting Analyze/Analysis Options from the menu or by clicking on the button on the tool bar. The B&D Kinetics Analysis Options window is displayed (shown above right).

1. Verify or select new analysis parameters. For information on these options, click the Help button.

2. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.

3. Click the Kinetics Plots tab at the top of the window. The window shown here is displayed.
4. Set up the plot parameters as desired. For information on these options, click the Help button.

5. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.

---

NOTE: To use the factory default options, click the Default button for each Analysis Options page.

---

NOTE: If you make a change to these parameters after analyzing the data, you will need to repeat the analysis again.

---

Analyzing the B&D Kinetics Data

The primary function of the B & D Kinetics analysis is to perform an integration analysis that calculates and reports:

- Activation energy (E)
- Log Pre-exponential Factor (log Z).

Select the type of baseline from the Analyze/Analyze BD menu (shown here).

When you select the baseline limits, the markers are displayed on the graph to allow you to select the analysis limits. The number of points requested depends on the type of baseline being used. See the online help for tips on using the markers.

Select the desired analysis limits and select **Accept Limits** from the pop-up menu. When the analysis is performed, the curve is integrated with respect to time between your selected baseline limits.

The program uses the sample size to normalize the area under the peak and obtain the experimental heat in joules per gram. If the sample size is zero, the heat is expressed in joules.
With any type of kinetics plot displayed, you can determine the X or Y curve value at a selected point using **Analyze/Curve Value at X** or **Analyze/Curve Value at Y**.
DSC Heat Capacity Analysis

The DSC Heat Capacity analysis is used to analyze data, from thermally stable solids and liquids, obtained from the Differential Scanning Calorimeter (DSC) instrument. Measurement of heat capacity, which is a structure-sensitive property, can be achieved by differential scanning calorimetry between -100° and 725°C. The measurement is made by heating a test specimen at a fixed rate over a designated temperature range, where the specimen is held in thermal equilibrium before and after dynamic heating according to ASTM Method E 1269.

The heat flow obtained from the specimen is recorded as a function of the actual sample temperature. This heat flow, normalized to the specimen mass and heating rate, is directly proportional to the specimen’s specific heat capacity.

To obtain specific heat capacity analysis you will need three DSC data files: a sample, a baseline, and a reference. The baseline data is used for baseline subtraction from the reference and sample data. See the online help for more information on gathering these data files. Typically sapphire is used as the calibration (reference) material, but other materials may be used.

After the three required files are specified and opened, the heat flow plot is displayed as seen here.
The current data file curve is indicated with a solid line. To change the currently active curve, select **Graph/File**, then choose the desired data file (Sample, Baseline, or Reference).

Tick marks are displayed on each curve. The two small vertical lines reflect the isothermal baseline limits. These should be positioned in stable heat flow regions (e.g., where no large fluctuations are present). These limits are used to shift the three experiments to zero heat flow for the heat capacity determinations. The program automatically selects these limits for you, however, to manually adjust these limits, select **Analyze/Isothermal Limits**.

The two I-bars reflect the analysis region. The common analysis region to all three experiments is used for the heat capacity analysis. To adjust this region, select **Analyze/Ramp Limits**.

The section entitled “Analyzing the Heat Capacity Data” on page 3-16 provides information on adjusting the analysis limits.

**Performing a Heat Capacity Analysis**

Follow these basic steps when performing a DSC Heat Capacity analysis. This section provides you with general information to get you started. Please refer to online help for detailed information.

1. Collect your data for sample, baseline, and reference. (See the online help for details.)
2. Open the Heat Capacity analysis and the appropriate data files.
3. Analyze the data:
   (a) Verify or edit the **Isothermal Limits** and **Ramp Limits** for each file.
   (b) Verify or edit the Analysis options.
   (c) Exclude any transition peaks, if desired. Select **Analyze/Remove Peak**, then choose the type of baseline for the excluded peak: Linear, Sigmoidal Horizontal, or Sigmoidal Tangent.
4. View heat capacity and total heat flow plots. (See Chapter 4.)
5. Display the results report. (See Chapter 4.)
6. Display the data table for heat capacity results. (See Chapter 4.)
Choosing Heat Capacity Options

After you have gathered the appropriate data files by running the needed experiments on the DSC, you can prepare to analyze them. With DSC Heat Capacity chosen as your analysis, first open the data files and set them up as desired (see Chapters 1 and 2 for information). Then choose the desired analysis options by selecting Analyze/Analysis Options from the menu or by clicking on the button on the tool bar. The Heat Capacity Analysis Options window is displayed (shown below).

1. Verify or select new plot parameters. For information on these options, click the Help button.

![Heat Capacity Analysis Options window]

2. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.

3. Click the Reference tab at the top of the window. The window shown on the next page is displayed.
4. Select the reference material used for calibration or set up a table for your own custom reference material. For information on these options, click the Help button.

5. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.

---

**NOTE:** To use the factory default options, click the Default button for each Analysis Options page.

---

**NOTE:** If you make a change to these parameters after analyzing the data, you will need to repeat the analysis again.
Analyzing the Heat Capacity Data

The isothermal limits and ramp limits are automatically chosen by the Heat Capacity analysis, but you may alter the limits, if desired. The complete process involved when analyzing heat capacity data involves three steps performed using the Analyze menu shown here:

- Verify or edit the Isothermal Limits for each of the three files.
- Verify or edit the Ramp Limits for each of the three files.
- Use the Analyze/Peak Exclusion menu to exclude any transition peaks, if desired.

When all steps have been completed you can view the results on the heat capacity plot by selecting Graph/Heat Capacity. With the heat capacity plot displayed you can determine the X or Y curve value at a selected point using Analyze/Curve Value at X or Analyze/Curve Value at Y.
**DSC Isothermal Kinetics Analysis**

The TA Instruments DSC Isothermal Kinetics Analysis program is used to analyze data obtained from the Differential Scanning Calorimeter (DSC) instrument. This program utilizes DSC data gathered by running a sample at various isothermal temperatures to compute kinetic results, and then generate the corresponding plots and tables.

Using isothermal DSC techniques to determine kinetic parameters provides many benefits over using dynamic kinetic techniques because the isothermal type of measurements...

- avoid thermal gradient effects
- eliminate errors due to nonlinear heating ramps
- minimize decomposition interference
- permit separation of multiple reactions (in most cases)
- permit the modeling of both Nth order and autocatalyzed reactions.

---

**NOTE:** The Isothermal Kinetics program is applicable to both Nth order and autocatalyzed reactions. However, it cannot be used to model endothermic reactions.

---

For details on the equations used in this analysis, refer to the online help.
Performing an Isothermal Kinetics Analysis

Follow these basic steps when performing a DSC Isothermal Kinetics analysis:

1. Collect your data. (See online help for details.)

2. Select File/New Analysis or click the button, then select DSC Isothermal Kinetics analysis.

3. Open the first data file. The window shown here is displayed. Mark the Isothermal Region as requested by positioning the markers, right click, and select Accept Limits from the pop-up menu.

4. Rescale the data file as desired. (See Chapter 2.)

5. Set up the desired analysis options.

6. Choose the desired Kinetics Model, if you have not already done so in step 5. (The kinetics model only needs to be defined once per analysis set.)

7. Select Analyze Curve from the Analyze menu:
   (a) Select the desired baseline type: Linear, Sigmoidal Horizontal, Sigmoidal Tangent, or User Defined points.
   (b) Mark the Baseline Limits as directed.
   (c) Compute area fractions by performing the steps: Mark Time Zero and Mark Integration Range.

   NOTE: You will be prompted to define the kinetics model upon selecting Analyze Curve, if you have not previously defined the model before beginning this step.

8. View the kinetics results for a single file. (See Chapter 4.) Adjust the conversion range, if necessary (select Analyze/Adjust Conversion Range).

3–18
9. Add at least two more additional files (preferably four or more total files) to the file set by selecting File/Add File. Repeat steps 3 through 8 for each data file. After the first file is opened, you can change the files included in the file set by selecting File/Edit File Set from the menu.

10. View the kinetics results for a multiple run file. See Chapter 4.
Choosing Isothermal Kinetics Options

After you have gathered the appropriate data files by running the appropriate DSC experiments, you can prepare to analyze them. With DSC Isothermal Kinetics chosen as your analysis type, first open the data file, mark the Isothermal Region, and set it up as desired (see Chapters 1 and 2 for information).

Then choose the desired analysis options by selecting Analyze/Analysis Options from the menu or by clicking on the button on the tool bar. The Isothermal Kinetics Analysis Options window is displayed (shown to the right).

1. Click the Isothermal Kinetics Model tab at the top of the page, if needed.

2. Select the equation, \textit{Nth Order} or \textit{Autocatalytic}, which you want to use as a model to analyze your data. For information on these options, click the Help button.

3. Select the definition that you desire for the available reaction orders—\(n\), \(m\), or \(n+m\)—as either variable or fixed values. If you choose fixed, you will need to a value for each fixed reaction order.

4. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.
5. Click the **Area Fractions** tab at the top of the window. The window shown here is displayed.

6. Set up the area fraction parameters as desired. For information on these options, click the Help button.

7. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.

8. Click the **Kinetics Results** tab at the top of the window. The window shown here is displayed.

9. Set up the parameters as desired. For information on these options, click the Help button.

10. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.
11. Click the Results Plot tab at the top of the window. The window shown here is displayed.

12. Set up the plot parameters as desired. For information on these options, click the Help button.

13. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.

14. Click the Conversion Plots tab at the top of the window. The window shown here is displayed.

15. Enter the desired conversion levels. For more information, click the Help button.

16. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.
NOTE: To use the factory default options, click the Default button for each Analysis Options page.

Analyzing the Isothermal Kinetics Data

After you have opened the desired data file, marked the isothermal region for the file, and chosen the kinetic model, the next step in the process is to analyze the data from each file.

Select the type of baseline from the Analyze/Analyze Curve menu (shown here). It is important that the baseline of the curve accurately represents the data. When you select the baseline limits, the number of points requested depends on the type of baseline being used.

- A **Linear** baseline requires you to choose two points to define the endpoints of the baseline.

- A **Sigmoidal-horizontal** baseline requires you to choose two points—Point 1 defines the beginning horizontal intercept, and point 2 defines the ending horizontal intercept.

- A **Sigmoidal-tangent** baseline requires you to choose four points. The first two points define the region of the beginning tangent, and the second two points define the region of the ending tangent. The sigmoidal baseline is derived between the two intercepts.

- A **User-defined points** baseline requires that you choose how many points (1 to 6) you want to use to compute the baseline. (The points are set on the Analysis Options — Kinetics Results Page.)

NOTE: If you have not already selected a kinetic model, the program will display a screen requiring you to do so.
You will be led through a series of instructions telling you how to proceed with the analysis. Follow the instructions needed to mark the baseline limits, mark zero time, and define the integration range.

When the analysis is performed, the curve is integrated with respect to time between your selected baseline limits. The program uses the sample size to normalize the area under the peak and obtain the experimental heat in Joules per gram.

After the file is analyzed, view the resulting plot and report for a single run analysis. (See Chapter 4 for details.) Adjust the conversion range used, if needed, by selecting Analyze/Adjust Conversion Range.

After you have done this for one file, add another file to the set by selecting File/Add File and repeat the procedure. When three or more files have been analyzed you can view the results from the multiple run analysis. See Chapter 4 for examples of the types of result plots and reports that are available for the DSC Isothermal Kinetics analysis.

With any type of kinetics plot displayed, you can determine the X or Y curve value at a selected point using Analyze/Curve Value at X or Analyze/Curve Value at Y.
TGA Kinetics Analysis

The TA Instruments TGA Kinetics Analysis program is used to analyze data obtained from the Thermogravimetric Analyzer (TGA) instrument. This program utilizes data gathered by running a sample at various heating rates.

The program allows you to analyze results from TGA data files to calculate the heating rate at each conversion percentage, and then generate plots and tables of kinetic analysis results.

The program operates in accordance with the ASTM Standard E1641 “Decomposition Kinetics by TGA.” A complete reading and understanding of this standard is considered an integral part of this analysis.

You must analyze data from at least three TGA data files in order to obtain kinetics results.

Performing a TGA Kinetics Analysis

Follow these basic steps when performing a TGA Kinetics analysis:

1. Collect your data. (See online help for details.)

2. Select File/New Analysis or click the button, then select TGA Kinetics analysis.

3. Locate and open the first data file.

4. Rescale the data file as desired. (See Chapter 2.)

5. Set up the desired analysis options.

6. Analyze the curve for a single file.

7. View the kinetics results for a single file. (See Chapter 4.)

8. Select File/Add File from the menu.

9. Repeat steps 3 through 8 for at least three (preferably four or more) TGA data files, if a multiple run analysis is desired. The TGA Kinetics analysis utilizes data file sets. After the first file is opened, you can change the files included in the file set by selecting File/Edit File Set from the menu.
Choosing TGA Kinetics Options

After you have gathered the appropriate data files by running the appropriate TGA experiments, you can prepare to analyze them. With TGA Kinetics chosen as your analysis type, first open the data file and set it up as desired (see Chapters 1 and 2 for information).

Then choose the desired analysis options by selecting Analyze/Analysis Options from the menu or by clicking on the button on the tool bar. The TGA Kinetics Analysis Options window is displayed (shown to the right).

1. Click the Calculation Options tab at the top of the page, if needed.

2. Select the desired conversion level percentages (we recommend at least three). Before a data file can be analyzed, the common points of conversion percentages must be identified. The percent conversion is determined by the percent weight loss between the start and stop limits. These conversion values will be used to generate the kinetics data.

Hints on Choosing Percent Conversion:

- When choosing the percent conversion that you want to use, please keep in mind that the percent conversion is calculated with your chosen start limits as 0% of the weight and your chosen stop limits as 100% of the weight.
• To obtain the best results, be sure to bracket the desired portion of the curve to determine the weight loss. (i.e., Pick a start point before the weight loss and an end point on the no-weight loss plateau, after the weight loss on the curve.)

• When you are performing analyses on small weight losses (less than ten percent), choose large conversion values (greater than five percent) to avoid problems caused by noise in the data.

For more information on these options, click the Help button.

3. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.

4. Click the **Results Plot** tab at the top of the window. The window shown here is displayed.

5. Set up the parameters as desired. They will be used in the generation of the results plots. For information on these options, click the Help button.

6. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.

7. Click the **Conversion Plots** tab at the top of the window. The window shown on the next page is displayed.

8. Set up the conversion levels as desired. They will be used in the generation of the Conversion Percent and Conversion Time plots. For information on these options, click the Help button.
9. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.

NOTE: To use the factory default options, click the Default button for each Analysis Options page.

NOTE: If you make a change to these parameters after analyzing the data, you will need to repeat the analysis again.
Analyzing the TGA Kinetics Data

After you have opened the desired data file, rescaled it, and selected the analysis options, the next step in the process is to analyze the data from each file. Select Analyze Curve from the Analyze menu (shown here) to perform the analysis on the current data file. The following guidelines should be considered when analyzing:

The following guidelines should be considered when analyzing:

- When you select Analyze Curve, the markers are displayed on the graph to allow you to select the analysis limits. See the online help for helpful information about using the limit markers.

- Select the desired analysis limits and select Accept Limits from the pop-up menu.

  NOTE: The heating rate used for kinetic analysis is based on the rate calculated at the first analysis limit. Therefore, this point should be chosen where the heating rate is stable.

- To obtain the best results, be sure to bracket the desired portion of the curve to determine the weight loss. (i.e., Pick a start point before the weight loss and an end point on the no-weight loss plateau, after the weight loss on the curve.)

After you have done this for one file, add another file to the set by selecting File/Add File and repeat the procedure. When three or more files have been analyzed you can view the results from the multiple run analysis. See Chapter 4 for examples of the types of result plots and reports that are available for the TGA Kinetics analysis.

With any type of kinetics plot displayed, you can determine the X or Y curve value at a selected point using Analyze/Curve Value at X or Analyze/Curve Value at Y.
The TA Instruments Thermal Stability Kinetics Analysis program is used to analyze data obtained from the Differential Scanning Calorimeter (DSC) instrument. This program utilizes DSC data gathered by running a sample at various heating rates.

The program operates in accordance with the following three ASTM* methods:


NOTE: It is strongly recommended that you obtain a copy of these procedures and review them to obtain a thorough understanding of the specific parameters measured, and the assumptions used in calculating those parameters.

* For more information go to http://www.astm.org or write to ASTM, 100 Barr Harbor Drive, West Conshohocken, PA 19428-2959, (610) 832-9500.

For details on the equations used in this analysis, refer to the online help.

Performing a Thermal Stability Kinetics Analysis

Follow these basic steps when performing a Thermal Stability Kinetics analysis. This section provides you with general information to get you started. Please refer to online help for detailed information.

1. Collect your data. (See online help for details.)

2. Select **File/New Analysis** or click the **button, then select Thermal Stability Kinetics analysis.
3. Locate and open the first data file.

4. Verify or enter the parameters needed on the **Calibration Parameters** window displayed here. These values are obtained from the **Analysis Options —Calibration Table** or, if no information is available in the table, from the data file. For information on these parameters click the Help button.

5. Rescale the data file as desired. (See Chapter 2).

6. Set up the desired analysis options.

7. Analyze the curve for a single file.

   **NOTE:** The heating rate used for analysis is based on the rate calculated at the first analysis limit. Therefore, this point should be chosen where the heating rate is stable.

8. View the kinetics results for a single file. (See Chapter 4.)

9. Select File/Add File from the menu.

10. Repeat steps 3 through 8 for at least three or more DSC data files, if a multiple run analysis is desired. The Thermal Stability Kinetics analysis utilizes data file sets. After the first file is opened, you can change the files included in the file set by selecting File/Edit File Set from the menu.
Choosing Thermal Stability Kinetics Options

After you have gathered the appropriate data files by running the appropriate DSC experiments, you can prepare to analyze them. With Thermal Stability Kinetics chosen as your analysis type, first open the data file and set it up as desired (see Chapters 1 and 2 for information).

Then choose the desired analysis options by selecting Analyze/Analysis Options from the menu or by clicking on the button on the tool bar. The Thermal Stability Kinetics Analysis Options window is displayed (shown to the right).

1. Click the Calculation Options tab at the top of the page, if needed. The window shown to the right is displayed.

A conversion level, in this type of analysis, is the point at which a certain amount of the sample has been converted (or reacted) to produce kinetic energy.

You have the option to select conversion at peak, at user-defined point (cursor), and / or a specific conversion % level (up to eight values) for which results can be computed in this analysis. The selected conversion levels are marked on each curve for each data file analyzed. The program can then treat the same conversion level from each file as a set and calculate the kinetic results.
The peak can be defined three ways: automatically by the program (Level at Peak), manually by selection with the cursor (Level at Cursor) or both simultaneously (by checking both options) in order to have the kinetic results computed at two different conversion levels in the same analysis.

2. Set up the parameters as desired. They will be used to calculate the kinetics results. For information on these options, click the Help button.

3. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.

4. Click the **Hazard Analysis Parameters** tab at the top of the window. The window shown below is displayed. This page is used to set up the default hazard parameters for the program to use when you perform the Thermal Stability Kinetics hazard potential analysis. Click the Help button for more information on these parameters.
5. Select a Shape Factor from those available in the drop-down list and enter the Dimensions, if appropriate.

6. Choose the desired method for obtaining Kinetic Parameters: either Automatic, from the analysis of data files, or Manual, from the list of parameters displayed.

7. If you choose Manual, enter the new values, then their uncertainty factor. Uncertainty refers to the possible range of imprecision involved in that kinetic parameter.

8. Enter the information and uncertainty factors for the sample material being analyzed in the Material Parameters set of fields.

9. Enter the temperature of the sample when it is placed in the environment as the Initial temperature and the temperature of the area around the sample as the Environment temperature.

10. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.

11. Click on the Results Plot tab at the top of the window. The window shown below is displayed.

12. Set up the parameters as desired. They will be used in the generation of the results plots. For information on these options, click the Help button.
13. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.

14. Click the Conversion Plots tab at the top of the window. The window shown to the left is displayed.

15. Set up the conversion levels as desired. They will be used in the generation of the Conversion Percent and Conversion Time plots. For information on these options, click the Help button.

16. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.

17. Click the Calibration Table tab at the top of the window. The window shown on the next page is displayed.

18. Select your DSC calibration material to be used as the standard (e.g., indium). For information on the calibration experiments needed, click the Help button. Enter the name of your calibration material in the Standard Name field.

19. Enter the Standard Onset Temperature for your calibration material.

20. Enter the Heating Rate, Onset Slope, Onset Temperature, and Cell Constant results obtained from your calibration runs.
21. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.
Analyzing the Thermal Stability Kinetics Data

After you have opened the desired data file, entered the calibration parameters, rescaled the plot, and selected the analysis options, the next step in the process is to analyze the data from each file.

Select the type of baseline from the Analyze/Analyze Curve menu (shown here). It is important that the baseline of the curve accurately represents the data. When you select the baseline limits, the number of points requested depends on the type of baseline being used.

- A Linear baseline (Analyze Curve/Linear) requires that you choose two points to define the endpoints of the baseline.
- A Sigmoidal-Horizontal baseline (Analyze Curve/Sigmoidal Horizontal) requires that you choose two points: point 1 defines the beginning horizontal intercept, and point 2 defines the ending horizontal intercept.
- A Sigmoidal-Tangent baseline (Analyze Curve/Sigmoidal Tangent) requires that you select four points. The first two points define the region of the beginning tangent and, and the second two points define the region of the ending tangent. The sigmoidal baseline is derived between the two intercepts.

The program uses the sample size to normalize the area under the peak and obtain the experimental heat in joules per gram. If the sample size is zero, the heat is expressed in joules.

NOTE: The heating rate used for analysis is based on the rate calculated at the first analysis limit. Therefore, this point should be chosen where the heating rate is stable.

After you have analyzed one file, add another file to the set by selecting File/Add File and repeat the procedure. When two or more files have been analyzed you can view the results. See Chapter 4 for examples of the types of result plots and reports that are available for the Thermal Stability Kinetics analysis.

With any type of kinetics plot displayed, you can determine the X or Y curve value at a selected point using Analyze/Curve Value at X or Analyze/Curve Value at Y.
Overview

After you have gathered and analyzed your data using any of the Specialty Library analyses you can view and print the associated graphs, data tables, and results. This section provides a brief description of the types of tables, reports, and plots available.

Viewing Reports and Tables

All analysis reports can be accessed from the View menu. When you select an item from the View menu, the Report window (shown here) is displayed to allow you to edit, print, or copy the report to the clipboard.

Common Reports

There are certain reports that are common to all of the analyses found in the Specialty Library. These common reports are:

- **Data Table**: Select View/Data Table to view the data from the currently displayed graph in the form of a data table.
• **Results Report:** Select View/Results Report to view the results of your analysis in a written report form.

• **Parameter Block Report:** Select View/Parameter Block to view a listing of the experimental parameters that were used when obtaining the data stored in the data file.

• **Method Log Report:** Select View/Method Log to view a listing of the method segments that were used to obtain the data file. Each experimental method is made up of a group of segments, which are preprogrammed instructions that are sent to the analytical instrument.

When you select any item from the View menu, the Report window is displayed to allow you to edit, print, or copy the log to the clipboard. The last two functions can also be accomplished using the pop-up menu shown here.

### Specialty Reports and Data Tables

Each Specialty analysis provides its own unique combination of reports and plots after data analysis. The analyses listed below produce special types of reports beyond the common reports listed on the previous page. For a brief description of the specialty-specific reports see this section. For more details refer to online help. For examples, select Help/How To? and click on “Get Final Plots and Reports?”

### DSC Purity

To view, edit, copy, or print the following reports, perform the analysis, then select one of the following menu items from the View menu in the DSC Purity analysis.

• **Area Table** is used to display a report showing a list of the total area divided by the partial area versus temperature results. The area table produced is based upon the analysis of the plot that is currently displayed.

• **Fit Table** is used to display a report showing a listing of the Purity fit results. The fit table is based upon the analysis of the plot that is currently displayed.
**DSC B&D Kinetics**

To view, edit, copy, or print the following reports, perform the analysis, then select the following menu item from the **View** menu in the TGA Kinetics analysis.

- **Half Life Table** is used to display a report showing a listing of the summary of the analysis calculations, sample information, and the parameters used in the analysis. The half-life table is based upon the analysis of the plot that is currently displayed.

**DSC Heat Capacity**

To view, edit, copy, or print the following reports, perform the analysis, then select the following menu item from the **View** menu in the TGA Kinetics analysis.

- **Custom Reference Table** is used to view the table, if you have entered a custom heat capacity reference table on the **Analysis Options - Reference Page**.

**DSC Isothermal Kinetics**

To view, edit, copy, or print the following reports, perform the analysis, then select one of the following the menu items from the **View** menu in the DSC Isothermal Kinetics analysis.

- **Curve Analysis** is used to view a table of the results obtained from the analysis of the heat flow curve.

- **Single Run Results Report** is used to view and print the analysis results obtained from the data file currently displayed.

- **Multiple Run Results Report** is used to report the multiple file analysis results. These include the reaction model used, the reaction enthalpy, activation energy, etc.

- **Data File Summary** is used to obtain a list of the data files contained in a file set. The list includes general information contained in each data file such as sample size, heating rate, etc. (To remove files from the file set, select **File/Edit Set**.)
TGA Kinetics

To view, edit, copy, or print the following reports, perform the analysis, then select one of the following menu items from the View menu in the TGA Kinetics analysis.

- **Curve Analysis** is used to view a table of the results obtained from the analysis of the heat flow curve.
- **Kinetics Report** is used to display a table showing pertinent kinetics results and the associated standard error.
- **Half-Life Table** is used to display a report showing a listing of the summary of the analysis calculations, sample information, and the parameters used in the analysis. The half-life table is based upon the analysis of two or more data files.
- **Lifetime Table** is used to view a report that describes the amount of time that the material analyzed will remain stable at specified storage temperatures.
- **Data File Summary** is used to obtain a list of the data files contained in a file set. The list includes general information contained in each data file—such as sample size, heating rate, etc.
Thermal Stability Kinetics

To view, edit, copy, or print the following reports, perform the analysis, then select one of the following menu items from the View menu in the Thermal Stability Kinetics analysis.

- **Curve Analysis** is used to view a table of the results obtained from the analysis of the heat flow curve.

- **Kinetics Report** is used to display a table showing pertinent kinetics results and the associated standard error.

- **Half-Life Table** is used to display a report showing a listing of the summary of the analysis calculations, sample information, and the parameters used in the analysis. The half-life table is based upon the analysis of three or more data files.

- **Hazard Results** is used to provide a report showing the results of the hazard analysis. These results include the following hazard potential figures of merit:
  
  - Time-to-Thermal Runaway
  - Critical Half Thickness
  - Critical Temperature
  - Adiabatic Decomposition Temperature Rise
  - Explosion Potential [EP] (dimensionless figure)
  - Shock Sensitivity [SS] relative to m-dinitrobenzene
  - Instantaneous Power Density [IPD] at 250°C (W/ml)
  - NFPA Instability Rating [IR]

- **Data File Summary** is used to obtain a list of the data files contained in a file set. The list includes general information contained in each data file—such as sample size, heating rate, etc.
Viewing Specialty Graphs

After you have performed the analysis on your data file, you can elect to graph and view the results using several different types of plots, selected using the Graph menu. A dot next to the name indicates the current plot. This section provides a brief description of the types of plots. You can print any plot after it is displayed by selecting File/Print.

For examples of these plots, refer to the online help. Select Help/How To, then click on “Get Final Plots and Reports?”

B&D Kinetics Analysis Plots

After you have opened a DSC data file, selected the analysis options, and performed an analysis, the plot options shown in the Graph menu (shown to the right) for the B&D Kinetics analysis will be available. Select one of the following menu items from the Graph menu in the DSC B&D Kinetics analysis.

- Heat Flow Plot is used to display the original heat flow graph with an inset listing the key kinetic parameters calculated by the analysis.

- Half Life plot is used to show time versus temperature, with a curve displaying the temperature of 50 percent reaction.

- Conversion Time plot is used to produce a conversion time graph, showing time versus temperature for up to five user-selected percentages of conversion. You can enter the percentages using the B & D Kinetics Plots Options Page, accessed by selecting Analyze/Analysis Options.

NOTE: The B & D Kinetics results plots selected are available only after you have performed a peak integration analysis.
• **Conversion Percent** plot is used to produce a conversion percent graph, showing percent of material converted versus time for selected temperatures. You can enter the temperatures using the B & D Kinetics Plots Options Page, accessed by selecting Analyze/Analysis Options.

• **Rate Constant** plot is used to graph the rate constant as a function of temperature.

• **Ln Rate Constant** plot is used to produce a logarithmic rate plot, showing the natural logarithm of the conversion rate versus reciprocal temperature. The degree of linearity of the graph shows how closely the Arrhenius model fits the reaction.

  A poor match, especially severe curvature in the plot of the logarithm of the rate constant, may indicate either problems with the particular experiment or the existence of complex reaction kinetics that are better modeled by isothermal DSC techniques.

### Heat Capacity Analysis Plots

After you have opened the three required DSC data files, selected the analysis options, and performed an analysis, the plot options shown in the Graph menu (shown to the right) for the Heat Capacity analysis will be available. A dot next to the name indicates the current plot. Select one of the following menu items from the Graph menu in the DSC Heat Capacity analysis.

• **Heat Flow** is used to graph the heat flow of the corrected reference and sample data files versus temperature.

• **Heat Capacity** is used to give you the heat capacity (energy/mass temperature) and total heat (energy/mass) of the sample data file plotted versus the temperature.

When the heat capacity plot is displayed, you can determine the Curve Value at X.
**DSC Purity Plot**

After you have opened a DSC data file, selected the analysis options, and performed an analysis, the plot produces displays the purity analysis results. You can print the plot after it is displayed by selecting **File/Print**.

**DSC Isothermal Kinetics Analysis Plots**

After you have opened at least two DSC data files, selected the analysis options, and performed an analysis, the plot options shown in the **Graph** menu (shown to the right) for the DSC Isothermal Kinetics analysis will be available. A dot next to the name indicates the current plot. Select one of the following menu items from the **Graph** menu in the DSC Isothermal Kinetics analysis.

- **Heat Flow** plot is used to display the heat flow of the data file versus time for the file selected.

- **Single Run Analysis** plot shows the log (reaction rate) versus the log (conversion term) for the selected file. If the correct model and correct conversion levels have been selected, the experimental data should fall close to the kinetics model line. If the calculated values are significantly removed from the line, different conversion level units should be selected or a different model should be used.

- **Multiple Run Analysis** is used to calculate and display the best fit for the set of data files already analyzed. This plot shows the reduced reaction rate, 1/k*dc/dt, versus the conversion level, c, for the various isothermal data sets. The circles represent the experimental data values while the solid line represents the kinetics model. If a good fit is not obtained, the individual data files should be reanalyzed using new parameters or a new model for the single file analysis, or the particular isothermal experiment should be redone.

- **Conversion Percent** is used to graph the percent of material converted versus time for a selected temperature. This allows you to determine the advantages of running the reaction at different temperatures. Select up to 10 temperatures to plot for Conversion Percent using the **Analysis Options - Results Plot** Page.
• **Conversion Time** is used to show a plot of time versus temperature for up to 10 user-selected percentages of conversion. Select up to 10 conversion percentages to plot for Conversion Time using the Analysis Options - Results Plot Page.

### TGA Kinetics Analysis Plots

After you have opened at least three TGA data files, selected the analysis options, and performed an analysis, the plot options shown in the Graph menu (shown to the right) for the TGA Kinetics analysis will be available. A dot next to the name indicates the current plot. Select one of the following menu items from the Graph menu in the TGA Kinetics analysis.

• **Weight** plot shows a plot of the weight versus temperature for the current file. It is the plot type that is normally displayed in the TGA Kinetics analysis after a data file has been opened.

• **Common Thermogram** is used to create a single plot of the thermograms available from all of the TGA Kinetics data files in your file set. They will be displayed on the common thermogram plot.

  Use the common thermogram to assess the quality of the original experimental data. Each thermal curve should have the same general shape. The weight loss should monotonically increase in temperature with increasing heating rate. If these conditions are not met, the experimental data is suspect and additional experiments may be needed to reduce uncertainty in results.

• **Heating Rate** is used to graph the rate at which the temperature changes over time versus $F[p(x)]$ for the analyzed data files. This curve may be used to test whether the experimental data fits the mathematical model on which the determination is based.

  The function $F[p(x)]$ should be a linear function of the heating rate. Data points should fit closely to the straight line. If the data points are curved, failure to fit the model is indicated. If the data is scattered, additional experiments may be indicated to improve results.
NOTE: See ASTM Standard E1641 "Decomposition Kinetics by TGA" for detailed information on $F[p(x)]$.

- **Log Heating Rate** is used to produce a graph known as the Arrhenius presentation. This curve may be used to test the applicability of the kinetic model to the experimental results and to check the precision of the individual measurements.

  The graph of log heating rate versus the reciprocal absolute temperature produces a straight line. The activation energy ($E$) is derived from the slope of this line.

  Data points should fit closely to the straight line. If the data points are curved, failure to fit the model is indicated. If the data is scattered, additional experiments may be indicated to improve results. In addition, the slopes of the respective lines should be parallel, if a single reaction mechanism fits all of the conversion levels. Changing slopes are one indication of a changing reaction mechanism.

- **Rate Constant** plot allows you to see how the temperature affects the rate of reaction. The rate constant plot depends upon the conversion levels that are selected on the **Analysis Options - Results Plot** page. Make sure that these items are set up as desired before creating the rate constant plot.

- **Half-Life** plot is a plot of time versus temperature with a curve showing the temperature of 50 percent reaction. The half-life plot depends upon the conversion levels that are selected on the **Analysis Options - Results Plot** page. Make sure that these items are set up as desired before creating the half-life plot.

  The half-life value may be used to further test the application suitability of a method. A test specimen, held for one half-life, should be 50 percent decomposed. The 60-minute half-life temperature is the temperature at which the test specimen should lose 50 percent of its weight in 60 minutes. Values that do not come close to these indicate a poor fit of the experimental results by this method.

• **Conversion Percent** is used to graph the percent of material converted versus time for a selected temperature. This allows you to determine the advantages of running the reaction at different temperatures. Select up to 10 temperatures to plot for the Conversion Percent Plot on the **Analysis Options - Results Plot** page.

• **Conversion Time** is used to show a plot of time versus temperature for up to 10 user-selected percentages of conversion. Select up to 10 conversion percentages to plot for the Conversion Time Plot on the **Analysis Options - Results Plot** page.

• **Lifetime** is used to graph the amount of time that the material analyzed will remain stable at specified storage temperatures. The lifetime plot depends upon the conversion levels that are selected on the **Analysis Options - Calculation Options** page and on the parameters chosen on the **Analysis Options - Kinetics Results** page. Make sure that these items are set up as desired before creating the lifetime plot.
Thermal Stability Kinetics Analysis Plots

After you have opened at least two DSC data files, selected the analysis options, and performed an analysis, the plot options shown in the Graph menu (shown to the right) for the Thermal Stability Kinetics analysis will be available. A dot next to the name indicates the current plot. Select one of the following menu items from the Graph menu in the Thermal Stability Kinetics analysis.

- **Heat Flow** plot shows a plot of the heat flow versus temperature for the current file. It is the plot type that is normally displayed in the Thermal Stability Kinetics analysis after a data file has been opened.

- **Common Thermogram** is used to create a single plot of the thermograms available from all of the Thermal Stability Kinetics data files in your file set. They will be displayed on the common thermogram plot.

Use the common thermogram to assess the quality of the original experimental data. Each thermal curve should have the same general shape.

- **Heating Rate** is used to graph the rate at which the temperature changes over time versus $F[p(x)]$ for the analyzed data files. This curve may be used to test whether the experimental data fits the mathematical model on which the determination is based.

In the Flynn and Wall kinetic model, which is the basis for ASTM* E698, a function $[Fp(x)]$ should be a linear function of the heating rate. This plot allows you to compare experimental data points with the best-fit straight line through the experimental data for each conversion option. If the data points show curvature, then the Flynn and Wall model is not suitable for this evaluation. If the data points are scattered around the line, then you may wish to check your experimental conditions and perform additional experimental methods in order to improve precision.
• **Log Heating Rate** is used to produce a graph known as the Arrhenius presentation. This curve may be used to test the applicability of the kinetic model to the experimental results and to check the precision of the individual measurements.

The graph of log heating rate versus the reciprocal absolute temperature produces a straight line. The activation energy (E) is derived from the slope of this line.

The scatter of the individual data points about the line provides a qualitative indication of the reliability of the calculated value for E. If the data points do not fall close to the line, it may indicate overlapping or competitive reactions.

• **Rate Constant** plot allows you to see how the temperature affects the rate of reaction. The rate constant plot depends upon the conversion levels that are selected on the Analysis Options - Conversion Levels page. Make sure that these items are set up as desired before creating the rate constant plot.

• **Half-Life** plot is a plot of time versus temperature with a curve showing the temperature of 50 percent reaction. The half-life plot depends upon the conversion levels. Make sure that these items are set up as desired before creating the half-life plot.

  The half-life value may be used to further test the application suitability of a method. A test specimen, held for one half-life, should be 50 percent decomposed. The 60-minute half-life temperature is the temperature at which the test specimen should lose 50 percent of its weight in 60 minutes. Values that do not come close to these indicate a poor fit of the experimental results by this method.

• **Conversion Percent** is used to graph the percent of material converted versus time for a selected temperature. This allows you to determine the advantages of running the reaction at different temperatures. Select up to 10 temperatures to plot for the Conversion Percent Plot on the Analysis Options - Results Plot page.

• **Conversion Time** is used to show a plot of time versus temperature for user-selected percentages of conversion.

• **Thermal Runaway Time Plot** is used to graph the time required for an exothermic reaction, in an adiabatic container (that is, no heat gain or loss to the environment), to reach the point of thermal runaway.
Index

A

absolute purity 3-3
activation energy 3-8
activation energy (E) 3-10, 4-13
analysis results deleting 2-3
analysis steps
DSC B&D Kinetics 3-8
DSC Heat Capacity 3-13
DSC Isothermal Kinetics 3-18
DSC Purity 3-3
TGA Kinetics 3-29
Thermal Stability Kinetics 3-30, 3-37
analyzing purity data 3-6
annotating plots 2-3
area fractions choosing for Isothermal Kinetics analysis 3-21
area table
DSC Purity 4-2
ASTM E1231 3-30

B

B&D Kinetics Analysis
analysis options 3-9
basic steps 3-8
description 3-8
integration analysis 3-10
performing analysis 3-10
sample preparation 3-8
baseline
DSC Purity analysis 3-6
linear 3-23, 3-37
Sigmoidal horizontal 3-23, 3-37
Sigmoidal tangent 3-23, 3-37
Thermal Stability Kinetics analysis 3-37
User-defined points 3-23

C

calculation options
Thermal Stability Kinetics 3-32

ASTM E698 3-30
ASTM procedure E0928 3-3
Autocatalytic kinetics model 3-20
axis limits returning to original 2-6

TA Instruments Specialty Library
calibration parameters  
   Thermal Stability Kinetics  3-31

calibration table  
   Thermal Stability Kinetics  3-35

clipboard  
   copying plots  2-3

colors  
   setting for program  1-11

common thermogram plot  
   TGA Kinetics  4-9

conversion levels  
   Isothermal Kinetics  3-22  
   TGA Kinetics  3-27

conversion percent plot  
   Isothermal Kinetics  4-8  
   TGA Kinetics  4-11

conversion time plot  
   B&D Kinetics  4-6  
   Isothermal Kinetics  4-9  
   TGA Kinetics  4-11

curve.  See also plot(s)  
   expanding portion of  2-5

curve analysis reports  4-3, 4-4, 4-5

custom heat capacity reference table  4-3

data  
   collecting  1-4

data analysis  
   basic steps  1-2

data file opening  
   settings for program  1-11

data file summary  4-3, 4-4, 4-5

data files.  See also files  
   adding to a set  2-1  
   removing from a set  2-2

data limits  
   returning to original  2-6

deleting  
   analysis results  2-3

directories  1-12

equation  
   van’t Hoff  3-3

experiments  
   collecting data  1-4

exporting plots  2-2

I–2  
TA Instruments Specialty Library
F

File menu  2-1

file set
   adding a file  3-24

files. See also data file
   information  1-7
   initialization  1-12
   setting locations  1-12

fit table
   DSC Purity  4-2

Flynn and Wall kinetic model  4-12

flyover help  1-2

folders  1-12

full scale plot  2-6

G

graph
   appearance  1-12

Graph menu  4-6, 4-8, 4-9

graphs. See also plot(s)

H

half-life plot
   TGA Kinetics  4-10

half-life table
   B&D Kinetics  4-3
   TGA Kinetics  4-4

hazard parameters
   Thermal Stability Kinetics  3-33

hazard results
   Thermal Stability Kinetics  4-5

Heat Capacity Analysis
   basic steps  3-13
   choosing isothermal limits  3-16
   description  3-12
   heat capacity plot  4-7
   heat flow plot  4-7
   isotherm plot  3-12
   opening data files  1-6

heat capacity plot
   Heat Capacity  4-7

heat flow  3-12

heat flow plot
   Heat Capacity analysis  4-7
   Isothermal Kinetics  4-8

heat of reaction  3-8

heating rate plot
   TGA Kinetics  4-9
   Thermal Stability Kinetics  4-12
help
  annotating  1-3
  flyover  1-2
  for the program  1-2
  menu items  1-3
  tool tips  1-2

Help button  1-3

I

impurity level  3-7

initialization file  1-12
  setting location  1-12

isotherm plot  3-12

Isothermal Kinetics
  single run analysis plot  4-8

Isothermal Kinetics Analysis
  adding file to set  3-24
  basic steps  3-18
  conversion levels  3-22
  conversion percent  4-8
  conversion time plot  4-9
  description  3-17
  heat flow plot  4-8
  kinetics results  3-21
  performing analysis  3-21
  results plot  3-22

K

kinetics report  4-4, 4-5

L

lifetime plot
  TGA Kinetics  4-11

log heating rate plot
  TGA Kinetics  4-10
  Thermal Stability Kinetics  4-13

Log Pre-exponential Factor (log Z)  3-10

M

main menu  1-8

menu items
  getting help for  1-3

method log report  4-2

mode
  used to open files  1-5

model
  choosing for Isothermal Kinetics
  analysis  3-20

multiple run results  4-3

multiple-file set  2-1
notes
  adding to help  1-3

online help  1-2
opening
  heat capacity data files  1-6
opening window  1-1
options. See also parameters
  B&D Kinetics analysis  3-9
  DSC Heat Capacity analysis  3-14, 3-15
  DSC Isothermal Kinetics analysis  3-20
  DSC Purity analysis  3-4
  DSC Purity calculations  3-5
  DSC Purity results plots  3-5
  TGA Kinetics analysis  3-26
  Thermal Stability Kinetics  3-32

parameter block report  4-2
parameters. See also options
  partial area  3-4
  peak area  3-6
  peak height  3-6
  percent conversion  3-26
plot
  appearance  1-12
  B&D Kinetics parameters  3-10
  changing line type  2-7
  copying to clipboard  2-3
  DSC Heat Capacity parameters  3-14
  DSC Purity parameters  3-5
  exporting  2-2
  full scale  2-6
  handling  2-1
  printing  2-2
  TGA Kinetics parameters  3-27
  Thermal Stability Kinetics parameters  3-34
plot area  1-8
plot(s)
  results  4-6, 4-7, 4-12
pop-up menu  1-8
printing
  reports  4-6
printing plots  2-2
program
  description  1-1
  parameters  1-11
  setting file locations  1-12
  settings  1-11
  starting  1-4
  purity  3-7
Purity Analysis
  description 3-3
  partial area 3-4
  performing analysis 3-6
  results plot 4-8

rate constant plot
  TGA Kinetics 4-10

reaction order 3-8

reference
  DSC Heat Capacity Analysis 3-15
  reference table 4-3

removing
  analysis results 2-3

reports
  common to all analyses 4-1
  curve analysis 4-3, 4-5
  data file summary 4-3, 4-4
  kinetics 4-4
  method log 4-1 to 4-2
  multiple run results 4-3
  parameter block 4-1 to 4-2
  results 4-1 to 4-2
  single run results 4-3
  Thermal Stability Kinetics analysis 4-5
  results
    deleting 2-3
  results plot
    Purity Analysis 4-8
  results report 4-2

S
  settings
    program 1-11
  Shape Factor 3-34
  single run analysis plot
    Isothermal Kinetics 4-8
  single run results 4-3
  Specialty Library
    description 3-1
    specific heat capacity 3-12

T
  tables
    half-life 4-5
  temperature
    plotting on x axis 2-7
  TGA Kinetics Analysis
    analysis options 3-26
    basic steps 3-25
    common thermogram plot 4-9
    conversion levels 3-27, 3-35
    conversion percent plot 4-11
    conversion time plot 4-11
    description 3-25
    half-life plot 4-10
    halftime plot 4-4
    heating rate plot 4-9
    kinetics results 3-33
    lifetime plot 4-11
TGA Kinetics Analysis (cont’d)
  log heating rate plot 4-10
  rate constant plot 4-10
  reports 4-4
  results plot 3-27
  setting calculation options 3-26
  weight plot 4-9

thermal runaway time plot
  Thermal Stability Kinetics 4-13

Thermal Stability Kinetics Analysis
  analysis options 3-32
  basic steps 3-30
  calibration table 3-35
  common thermogram plot 4-12
  conversion percent plot 4-13
  conversion time plot 4-13
  curve analysis report 4-5
  data file summary 4-5
  description 3-30
  half-life plot 4-13
  half-life table 4-5
  hazard potential analysis parameters 3-33
  hazard results 4-5
  heat flow plot 4-12
  heating rate plot 4-12
  kinetics report 4-5
  log heating rate plot 4-13
  performing the analysis 3-37
  rate constant plot 4-13
  results plots 4-12
  setting calculation options 3-32
  thermal runaway time plot 4-13

tool bar 1-8

tool tip
  help 1-2

V
  van’t Hoff equation 3-3

View menu 4-1

W
  weight plot
    TGA Kinetics 4-9

window
  first 1-1
  main 1-8

Z
  zoom tool 2-5